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The PowerRIP DirectAdvantage contains color management software.  It is designed to work with the 
DirectAdvantage® printer and Sawgrass NaturaLink® inks in order to optimize your color output.  Follow 
the instructions below to install this software on your computer. 
 
Important Note : If there is a prior version of PowerRIP in your computer, be sure to remove (uninstall) it 

before beginning the new installation.  In addition, manually remove these two folders 
from the C:/ directory in your system: PowerRIPDA and PowerRIPHotFolders. 

 
1. Insert the PowerRIP DA CD into your computer CD drive.  Select Open folder to view files using 

Windows Explorer (see illustration below left) and double-click on the PowerRIPDAW_744_CD.exe 
application file, where ‘744’ is the version build of your program (7.4.4 N at the time of this writing, but 
this designation changes according to version).  A WinZip Self-Extractor window will open up and 
display the folder to which the PowerRIP files will be extracted (see illustration below right). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Click on Browse in the WinZip Extractor window 

and select ‘C:’ as the destination drive for the 
PowerRIP program folder, which will be 
C:\PowerRIPDA_CD .  Otherwise, the program 
will attempt to create this folder on the CD drive 
itself and result in an error. 

 
3. Leave the check boxes labeled, “Overwrite files…” and 

“When done unzipping open…” checked and click on 
Unzip to unzip the files and begin the program 
installation wizard. 

 
4. On the Installation Options window that opens up, 

select Install/Remove/Repair PowerRIP DA (see 
illustration at right). 
 

5. On the next window--the PowerRIP Direct Advantage 
Set-up (Welcome) window—select Next. 
 

6. Click on Yes on the next screen to accept the license 
agreement. 
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7. Fill in the customer information (User Name, 

Company Name) in the fields provided on the 
next screen.  You may leave the default 
EVALUATION value on the Serial Number 
field.  You will be entering the required, 
appropriate information during program 
registration.  Then click on Next to advance to 
the next screen (Select Printer Drivers). 
 

8. On the Select Printer Drivers screen, leave all 
of the selections checked, unless you have 
reasons no to install specific drivers, in which 
case you uncheck the drivers you do not want 
installed (see illustration below).  It is best to 
leave ALL of the options checked, as this list 
contains not only the printer driver files but 
also the executable program and support files!  
Then click Next. 
 

9. On the Select Program Folder window, accept the default folder, which is PowerRIP Direct Advantage, 
and which the program will create, and then click on Next.  
 
The program begins the installation as denoted by the progress bar (see illustration below. 
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10. On the Select Print Queues to Create window, 
you will see four drivers highlighted—
DirectAdvantage w/White Ink; DirectAdvantage 
Double Color; PowerRIP PDF, PowerRIP TIFF.  
Leave all four choices highlighted and click on 
Continue to advance to the next screen. 

 
11. As the queues are being installed, the program 

will notify you of the completion of each individual 
installation.  Click OK on each of these four 
windows to advance to the next stage.  In 
addition, if a driver already exists in your system, 
the program will detect it and ask if you want to 
update it (see illustration below).  Click Yes.   

 
 
 

 
12. When the installation is complete, 

the system will ask you if you 
want to restart the computer. 
Select Yes, I want to restart my 
computer now and then click on 
Finish. 

 
13. After a full restart of the computer, be sure to print 

the User’s Guide by following this step sequence 
from the Windows Start menu:  Start�  All 
Programs� PowerRIP Direct 
Advantage� Documentation� PowerRIP DA 
Manual. 

 
14. You must now validate  your software package in 

order to eliminate the watermark that will 
otherwise appear on all of your prints.  To validate 
the software you just installed, run the PowerRIP 
program (double-click on the PowerRIP icon on 
your desktop), click on the Configure menu, and 
select Validate Software (see illustration below). 

 
 
15. A PowerRIP Validation window will open up.  Consult your PowerRIP Direct Advantage User’s Guide 

and follow the steps located on the section titled Validating PowerRIP Direct Advantage to validate your 
software. 
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IT IS STRONGLY RECOMMENDED THAT YOU READ THE ENTIRE  PowerRIP DA  USER’S GUIDE 
BEFORE PROCEEDING TO THE PRINTING INSTRUCTIONS THAT  FOLLOW. 
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There are several techniques you can use to rip an image and print it on a cotton garment so that the final 
output conforms to your specifications.  The quickest way is to use the Create Job feature in PowerRIP for 
Direct Advantage.  Unless you need to modify the artwork (such as when you need to remove a 
background or edit a bitmap), you do not have to use such applications as CorelDRAW and Adobe 
Photoshop.  If you have a jpeg, tiff, gif or psd  file that you need to rip for printing on your Direct Advantage 
printer, you can open the file directly in PowerRIP, rip it, and send it to the Advantage Queue for printing.  
 
The first section of this Quick Guide describes the procedure for bringing an image directly into PowerRIP, 
ripping it and sending it to the Direct Advantage (DA) Queue for printing.  Subsequent sections cover the 
preparation of an image in a separate application, such as CorelDRAW and Adobe Photoshop, ripping it 
and sending it to the DA printer for final output.  This document is designed to be a quick and easy guide to 
these procedures.  For more detailed information on editing and ripping unusual or complex images, please 
refer to the user manuals for the specific applications. 
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To open and rip an image file using PowerRIP, proceed as follows: 
 
1. From the PowerRIP main window, click on 

the File menu and select Create Job (see 
illustration at right).  The Create Print Job  
window will open up  

 
2. In the Create Print Job  window, click on 

File and select Import Graphic (see 
illustration below).  Navigate to the folder 
where you have stored your image file and 
select it (see illustration below right).   

 

 
 
Alternately, you may click on the chosen job in the 
folder and simply drag and drop it into the image 
area of the “Create Print Job” window. 
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3. Wait for the image to arrive at the RIP and position it at your will.  At this point, you can also resize the 
image to fit your desired output size.  To move the image, simply click anywhere inside the image area 
and drag it.  To resize it, click on the “handles” (small squares) at the corners of the image area and 
extend or contract the image.  You also have the option of centering the image on the screen, 
horizontally, vertically or both.  These choices are accessible from the Artwork  tab (see illustrations 
below). 

 
 
4. Select your printing parameters—print quality (resolution), media (white or color cotton, or paper), print 

direction (uni-or bid-directional printing), density (for the white layer) and number of passes for each 
layer (color and white).  Of course, if you will be printing in color only, such as when you are printing on 
a white T-shirt, you need not concern yourself with white-ink settings.  You can set the printing 
parameters in one of two ways (see illustrations A and B below): 
 

a. Select predefined parameters.  Click on the Pre-defined Settings  drop-down menu arrow at 
the top right of the screen to make your choice (see illustration A below).  The most common 
one is Black Cotton, 720 or White Cotton, 720, depending on whether you will be printing on 
black or white cotton, respectively. 

 
 Fig. A: Pre-defined printing parameters  Fig. B: Defining parameters manually: 
 

b. Define the parameters, one by one, manually.  Click on the Print Settings  tab to display all of 
these choices (see illustration B above).  When you define your printing parameters this way, 
you can save them for later use, in which case you can recall them from the “Pre-defined 
Settings” field. 

 
The most common settings are as follows: 

·  Media: black (or white) cotton 
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·  Print Quality (Color Layer): 720 x 720 (dpi) 
·  Print Density (White Layer): 1440 x 1440 (dpi) 
·  White Passes: 1 
·  Color Passes: 1 
·  Print Direction (Color): Bidirectional 
·  Use Dual CMYK: Check this box only if your Direct Advantage printer is not using white ink 

and, instead, has two sets of color inks installed—one on each side. 
 
5. Click on the Color Settings  tab and select your 

color settings (see illustration at right).  For 
most applications, the best all-around color 
settings to use are these: 
·  RGB source Profile: RIP Default (this is the 

sRGB Profile) 
·  CMYK Source Profile: RIP Default (this 

equates to “None,” or no profile applied) 
·  Output Profile: Auto-Select 
·  Color Appearance: Photo Normal (for 

photographic images) or Vivid/Darker (for 
text and vector images, or if you prefer 
higher color saturation). 

 
 
 
6. If you are printing with white ink, you are now ready to generate the white layer (underbase, or mask).  

Be sure that the image is selected (if not, simply click on it to select it) and click on the White Ink 
Control  tab.  Begin by selecting what you want the RIP to use to generate the underbase—the 
background color, 100% white under any color pixel, underbase entire image, etc.  In the example 
shown, the option Use Transparency to Detect Background was chosen because the original image 
was created with a transparent background.  Click on Create to begin generating the white layer (see 
the first two illustrations below).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Clicking on the White radio button at the top left of the Create Print Job screen, enables you to see the 
white mask you have just created. 
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7. Click on the Preview radio button at the top of the screen to view the completed image, and click on the 
Set Material Color (for previewing only) to generate a preview of your composite image as it would look 
on the selected background (black cotton, in this example.  See the illustrations that follow). 
 

 
 
8. Click on the square that represents the color of your garment (black in this example), and then click OK 

(see illustrations below).  Your preview will now be generated, and you will see the composite image 
set against the selected background. 

 

 
 

 
9. Save your job  before proceeding, as you might 

need to rework the image and re-rip it before 
printing.  To save the job, select File from the main 
menu and then select Save Job (see illustration at 
right).  Select the folder where you want the job to 
be saved and give the file a name.  

 
 
10. Now, click OK to instruct PowerRIP to proceed 

with the ripping of this image (see illustration on 
the next page). 

 
This window will close, and ripping ensues.  The main 
RIP window will open, and the name of the file being 
ripped will appear in the Incoming Jobs  screen. 
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Once ripping is completed, the file will automatically transfer to the Processed Jobs  window (see 
illustrations below) and, from there, immediately to the Direct Advantage Queue 
 

 
11. Click on the Processed Jobs  tab and double-click 

on the name of the file to see a preview of the 
ripped job.  A preview window will open showing 
the image as it will look in its final form when 
printed (see illustration at right).  In this window, 
you can selectively view the white layer (mask), 
the color layer, or the composite image against 
your selected fabric color.  If the ripped image 
does not conform to your requirements, you can 
edit it in your preferred application and re-rip it 
before printing it. 

 
 
 
 
 
 
 
 
 
 
Section 5  describes a common procedure for editing the white mask of an image. 
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This section describes the most common procedure for ripping and printing a job onto a black garment 
using CorelDRAW version 12, 13 or X4.  To achieve the desired results when following this auto-masking 
procedure, it is imperative that your artwork is laid on a black bac kground . 
 
1. In CorelDRAW, select Color Management from the Tools menu and verify that this function is active, 

i.e., the arrows are orange.  If not, click on the arrows, and they will turn orange.  Verify also that you 
have the correct profile being applied.  If not, click on the small down arrows below the desktop printer 
and web offset press icons and select the DirectAdvantage_Master.ICM  profile from the drop-down 
list (see illustrations on the next page for reference). 
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2. Now select File > Print and select Direct 

Advantage w/White Ink  as the printer of choice 
(see illustration below).  If you get a warning 
about non-matching "printer paper orientation," 
click “No” (so as not to choose automatic 
adjustment by the system). 

 
3. Click on the Properties button, then click on the 

Advanced button (refer to the illustration blow). 
 
 
 
 
 
 
 
 

 
 
4. Change the following RIP settings to the values 

shown below (for reference, refer to the screen 
images that follow, but use the platen size specified, 
not necessarily that which is shown on the screen 
captures).  Leave all of the other settings not listed 
here at their default values: 

 
·  Paper Size: 17 x 18 Platen  
·  Print Quality: 720 x 720. This setting specifies the color printing resolution in dpi. 
·  Color Appearance: Photo-Normal .  This setting instructs the RIP how much color ink to lay down 

and it normally yields the best results with raster (photo) images.  Select "Vivid-Darker" for vector 
and text artwork, or if you want more color intensity (although you might sacrifice color accuracy). 
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·  Layer Type*: Color Layer Auto-Mask (Black Bkgd).   This setting instructs the RIP to use the 
black background in place of black ink where this ink is called for, and thus not to lay white ink on 
those areas.  This option works only on pure black fabric.  With other colors, use this option in 
conjunction with Capture Black. 

·  Media Type: Black Cotton.  Always use this setting when printing on a black or dark-color fabric. 
·  White Ink Resolution: 1440 x 720.  This setting determines the resolution of the white ink in dpi.  

The higher this number, the tighter the coverage (and the more intense the white).  You want the 
tightest white coverage to be sure that the layered colors are reproduced with maximum fidelity. 

·  Black Ink/Underbase Behavior*: No Underbase, No Black Ink. This is the only setting allowed 
when you select “Color Layer Auto-Mask (Black Bkgd)” as the layer type.  The setting instructs 
the RIP not to lay down white ink in the black areas of the image and not to lay down black ink 
either in those areas.  The black color of the fabric is used in place of black ink. 
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* Note: Whenever a selection is in conflict with 

another (e.g., you selected an 8.5” x 11” print 
area, but you have a 10” x 16” image), a 
warning icon (a small yellow triangle) will 
appear next to the conflicting options.  Do not 
print until all conflicts are resolved.  See 
additional information on layer types and 
resulting conflicts in Section 4  of this 
document. 

 
 
 
 
 
 
 
 

5. Click “OK” twice to conclude this dialog and then click “Print.” 
 
At this time, the image is sent to the RIP.  It will take a few minutes to process the image.  Take this time to 
mount the T-shirt on the platen.  Once the image is ripped, PowerRIP will automatically transfer it to the 
Direct Advantage Queue. 
 
6. Click on the name of the file in the Advantage Queue job view area (the upper window) and drag it into 

the printer in the printer view area (the lower window). 
 
7. Once the image is printed, carefully remove the garment from the platen and cure it on a heat press set 

at 340° F, for 2 min 20 sec at very low pressure (1 0 - 12 psi). 
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This section describes the most common procedure for ripping and printing a job onto a black garment 
using Adobe Photoshop version 8 (CS).  To achieve the desired results when following this auto-masking 
procedure, it is imperative that your artwork is laid on a black bac kground. 



 

13 

 
I. Adobe Photoshop CS 
 
1. Select File > Page Setup from the main menu (see illustration at right).  
 
2. On the “Page Setup” window that opens up, click on Printer (see illustration 

below), select the “Direct Advantage w/White Ink” printer, and click OK to 
conclude this selection (see illustrations below). 

 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
3. On the Size drop-down menu, select “17 x 18 platen” 

(disregard the size shown on the screen capture), and 
select “Flatbed” from the Source drop-down menu (see 
illustrations at right and below). 
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4. Return to the File menu and select the Print with 

Preview option.  In the “Print” dialog window that 
opens up, make sure that the checkbox beside 
Show More Options is checked.  If not, check it 
(see illustrations at right). 

 
 
 
 
5. Select Color Management from the drop-down 

menu, and check the radio button beside Document 
in the Source Space  submenu (see illustration 
below right).  

 
6. Still in the Color Management menu, in the Print 

Space submenu, click on the down arrow in the 
Profile  selection field and select the 
DirectAdvantage_Master.ICM  profile from the pull-
down menu that appears.  The selection on the 
Intent field should be Perceptual .  If not, click on the 
down arrow in this field and select Perceptual from 
the drop-down list (see illustration at right). 

 
7. Click on Print and select the Direct Advantage 

w/White Ink  as the printer of choice. 
 
8. Repeat steps 3 trough 7 in the CorelDRAW 

procedure described above.  There is an exception 
to step 5 where, in Adobe Photoshop, you click OK 
three times (instead of twice), and the selection Print 
does not appear at the end of the dialog (essentially, 
the third OK substitutes for Print). 

 

 

 



 

15 

��������,�(�����!�������-����- �+.���/����+��-����� �%�/��"�

PowerRIP Direct Advantage offers two auto-masking layer types for printing with white ink--Color Layer 
Auto-Mask (Black Bkgnd) and Color Layer Auto-Mask.  If you are printing on a white garment, ignore all 
other layer types and simply select Color Layer.   In addition, you can also choke the white underbase if 
there is a chance that the white will “peek” from the color layer, especially at the edge of an object.  
Choking will enable you to instruct the RIP not to lay white ink on an outer row or column of pixels by a 
stipulated amount. The information in this section applies only when you are using white ink, as is the case 
when you print on black or dark-color garments. 
 
·  Color Layer Auto-Mask (Black Bkgnd .  Be sure to select the option No Underbase/No Black Ink 

when using this type of automatic layer.  If you print an image that has a black background and you 
select the Light Underbase, Use Black Ink option, the entire black background will print, thus leaving a 
black box on your garment! 
 

·  Color Layer Auto-Mask .  If there are no pure (100%) white areas in the image, and you are printing 
on a colored garment, choose the Color Layer Auto-Mask layer type and do not create a black 
background around the image.  This selection instructs the RIP to treat all 100% areas as a physical 
white background, and therefore not to print anywhere there is 100% white.  As a result, the printer will 
not print on any 100% white areas in the image--but it will print process white --and the color of the 
garment replaces the pure (100%) white (which is the background) in the image. 
 

·  Capture Black .  Use this feature in conjunction with Color Layer Auto-Mask (Black Bkgnd) whenever 
black ink must be used.  This is the case when you are printing on a colored shirt, and the image has 
black areas.  This layer type causes the RIP to capture and store the black channel (either pure black 
or composite) so it can be superimposed on the next color layer.  
 

·  When you print white at 1440 x 1440 dpi, you might want to reduce the amount of white ink being laid 
to prevent bleeding.  A common setting is 90, but use the value that results in the most white ink being 
laid down without bleeding.  On the other hand, if you are using a 720 x 1440 resolution, leave the 
white (W) density value at 100.  You make this adjustment in the following “PowerRIP Advantage” 
menu/submenu tree: Utilities > Printer & Ink Configuration > Ink Configuration.  In the Ink Configuration 
Type window, slide the W bar to a value of 90 (see illustrations below). 

 

 

 

 

 

 

 

 

 

 

 

 

 

�%�/��0�#��+1  In the RIP, there is an option that enables you to choke the white underbase in cases 
where you find the need to eliminate the possibility of the white layer “peeking out” from under the color 
layer.  This phenomenon often results when you print the two layers--white and color--at different 
resolutions (1140 x 1440 dpi for white, 720 x 720 for color).  By default, the choke value is set at minus one 
(-1), which causes the RIP to choke the underbase by one pixel width in all four directions.  It is 
recommended that you remove choking altogether by setting the values to zero.  If you choose to retain the 
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choking, however, please be aware that certain fine traces and small-point text may not be visible in the 
final print.  This is because, in these situations, choking the underbase will essentially remove the white 
layer in these areas, rendering the color layer nearly invisible on a black T-shirt. 
 
The choking option is accessible from the Utilities > Printer & Ink Configuration  > Choke & Feed 
Adjustment menu tree in the RIP.  To remove choking, change the four (Top, Left, Bottom and Right) choke 
values from -1 to zero. 
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Sometimes, the choices available for white ink control in Create Job within PowerRIP are not sufficient to 
produce a final image without either undesirable, or improperly rendered, white areas.  Such is the case 
when your image has a white background (standard photographs are one example).  If you select the Use 
Background Color to generate the white layer, PowerRIP will generate a white square underlying the entire 
image (see image below).  The same outcome will result if you choose the Underbase Entire Image option.  
This might not be what you want your final image to look like. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
On the other hand, if you select the 100% White 
under Any Colored Pixel option, the circular area 
inside the signs will receive no white ink (there are no 
color pixels there), and the color of the shirt will show 
through (see image at right).  Again, this might not be 
the optimum or desired outcome for this type of 
image. 
 
One way to get around this issue is to fill the image 
mask (the white layer) with color—black in this case.  
The Rip, however, provides no means to accomplish 
this task, so you will have to use an outside 
application, such as Corel Photo-Paint, to edit the 
white layer.  
 
To edit the white layer so PowerRIP can use it in its new form, you will need to export it, edit it in the 
application, and then import the edited version into PowerRIP.  Different images will require different 
editing.  Some images are best processed if you remove the background entirely; others rip and print well if 
you apply a transparent background, and still others, such as the example being used here, require other 
minor editing.  In this example, the procedure is as follows: 
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1. Generate the white layer using the 100% White 

under Any Pixel option.  When you view the 
resulting white layer (mask) you will notice that the 
mask is white where there will be no white ink laid 
down, and it appears black where there is color and, 
therefore, white will be printed (see the image at 
right). 

 
2. Select Export White Channel from the Export menu 

in PowerRIP (see illustration below), and save the 
image with a file name of your choice.  The resulting 
file will be a TIF file. 

 
 
 
 
3. Edit the image in your favorite application by filling 

the circular area inside the signs completely with 
black (see image below), and save the file (you will 
be overwriting the original white mask). 

 
 
 
 
 
 

 
 
 
 
 
4. In the PowerRIP White Layer 

Generation tab, select the 
Import from File option to 
create the new white layer and 
click Create (see image blow). 

 
 
 
 

 
5. Select the edited file from the folder where you saved it 

(see illustration below) 
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PowerRIP will now use this edited image to re-create 
the white mask.  Once finished, the white layer will 
look like the image at right--exactly like the image you 
edited in, and just saved from, Corel Photo-Paint. 

 
 
6. The final output will now look like this (see illustration 

below): 
 

 
 


